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Introduction 

Overview 
The MLS file viewer is an application that has been developed to allow you to 
quickly view and print the contents of any file that contains data formatted using the 
CAMARC DST specification or the public domain C3D file specification.  These are 
both file formats that are widely used to store both raw biomechanics data (C3D), 
and well as processed gait data (C3D, DST and GCD). 

 
The MLS file viewer has a simple to use interface. 

Installation 
You can use the Windows Add/Remove Programs option in Control Panel to install 
the MLS file viewer from a floppy disk or CDROM.  If you download a copy from 
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our ftp site on the Internet (ftp.emgsrus.com), then just run the installation file.  This 
will install the program on your system together with some example files that you 
can use to demonstrate and play with the program. 

During installation The MLS file viewer will prompt you to enter a license number - 
if you do not have a license then you can run in evaluation mode by entering 0000-
0000-0000-0000 as the serial number.  If you have obtained a license to run the 
program from Motion Lab Systems then enter your license number together with 
your User Name and Organization details exactly as supplied on your license 
certificate. 

If you accept the default options during installation, then you will have created a 
short-cut in the Gait Lab menu group called MLS – The MLS file viewer together 
with a desktop short-cut. 

The MLS file viewer shows the name of the registered user in the About dialog box 
accessed from the help drop-down menu.  This can be opened by choosing the About 
command (Help menu.  This dialog box will also show you the Version Number of 
the program. 

Evaluation Mode 
If you do not have a license for the application then the MLS file viewer will run in 
an evaluation mode so that you can try out the product before you purchase a copy.  
When the program is installed as an evaluation version you will not be able to print 
copies of any of the graphed data.  You can purchase a registration key and manual 
from Motion Lab Systems, Inc. 
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Using the Program 

The User Interface 
When the Motion Lab Systems The MLS file viewer program is started the 
application window will appear - this will be blank except for a menu bar and 
Toolbar that appear at the top of the window.  The program (like all MLS programs) 
is a 32-bit Windows 95/NT application and will respond to all the normal commands 
to position and control the display.  It can be represented on the screen in one of the 
three ways: full screen (maximized), as an application icon (minimized), or within a 
window (restored).  The application remembers the state in which it was when it was 
last used and the size of the main window and the position of the Toolbar will be the 
same. 

The name of the current data file that is being analyzed will be displayed in the top 
left corner of the application (after the name of the Application).  When more than 
one file is open the file name will be the name of the file window that is currently 
selected. 

You can view each file maximized (so that the entire view window fills the MLS file 
viewer application) or you can tile the file windows so that you can view the contents 
of the files simultaneously. 

 

At this point virtually all the commands that you will need are on the short-cut bar at 
the top of the program window.  You can select items within any active data window 
simply by clicking on them to display their values or view the data. 
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Application Workspace 
Each data file that is opened in The MLS file viewer has a Window of its own within 
the application.  The MLS file viewer can have several files open at the same time so 
that you can compare the contents of one file with another. 

 

The contents of the data file are displayed in the form of a tree.  The tree will have 
one or more of the items. 

File Menu 
The File Menu can always be selected from the left side of the Menu Bar.  This 
menu contains commands that operate on files and is used to select files to be 
opened. 

A list of recently opened files is always displayed at the bottom of the File Menu so 
that you can rapidly access any of the last few files that you have been working on. 
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Open 

 Shortcut – C TRL+O 

The Open command is available on the MLS file viewer toolbar at the top of the 
application window or via a keyboard shortcut.  The toolbar button has a drop down 
arrow, clicking on which will give you a list of recently opened files. 

This command can be used to open an existing data file.  The application 
automatically determines the format of the file and reads the data from the file using 
the correct format and/or lexicon. 

The open command opens up a standard windows File Open Dialog box and allows 
the user to browse through the directories and select the correct file by simply 
double-clicking on the filename.  Each file is opened in its own window. 

A file can also be opened by dropping it into the application workspace or by double 
clicking on it in the Windows Explorer if the file type has been associated with this 
application. 

The following different data files are recognized by the application: 

DST Files 
The CAMARC file format defines a file format for the storage and exchange of data. 
The specification is given the acronym DST meaning Data Storage and Transfer. 
This format is quite simple and general in its definition and can be used equally well 
for the transfer of a few lines of text or a complete 3D kinetic clinical gait analysis 
experiment. It is not specific to any particular type of data, any make of equipment, 
or even biomechanics. 

As DST files are written in ASCII code they are not especially compact and are 
generally not used for the storage and transfer of very large raw data. In general, raw 
data files are specific to the instruments on which the measurements are made, and 
data exchange is usually limited to owners of that equipment.  

If you are interested in accessing or transferring large amounts of data from binary 
files to the DST format then you may want to look at RData2 – an application 
written by Motion Lab Systems that translates a number of binary file formats to a 
variety of ASCII text formats (including DST output). 

DST files are generally stored as a sequence of samples over a period of time. 

GCD Files 
The CAMARC project defines a basic data lexicon for the storage and exchange of 
processed data within the DST format. The specification is given the acronym GCD 
meaning Gait Cycle Data.  This specification builds on the DST format description 
to specify the way in which data can be stored as the results of gait analysis. 

The GCD lexicon is quite simple and defines data as a number of samples within a 
gait cycle. 

Close 

 

The Close command is available on the MLS file viewer toolbar at the top of the 
application window or via a keyboard shortcut. 

This command can be used to close the current open file.  If any changes have been 
made to the file, which have not been saved, The MLS file viewer will prompt you to 
save them before it closes the file. 

This command is available only when a file is open. 
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Save 

 Shortcut – C TRL+S 

The Save command is available on the MLS file viewer toolbar at the top of the 
application window or via a keyboard shortcut. 

This command is used to save the open data file to the same name. 

Save As 
The SaveAs command is available on the MLS file viewer toolbar at the top of the 
application window or via a keyboard shortcut. 

This command is used to save the data file to a file with another name.  If the 
selected file already exists, the application prompts you as to whether it should over 
write the file. 

Print command (File menu) 

 Shortcut – C TRL+P 

The Print command is available on the MLS file viewer toolbar at the top of the 
application window or via a keyboard shortcut. 

Use this command to print a document.   This command presents a Print dialog box, 
where you may specify the range of pages to be printed, the number of copies, the 
destination printer, and other printer setup options. 

This allows you to print the graph of the selected item in the Main View.  It does not 
allow you to print items that cannot be plotted 

Printing is possible only when you have registered this application. 

Print dialog box 
The Print dialog box appears whenever you want to print a graph. 
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The following options allow you to specify how the document should be printed: 

• Printer 
This is the active printer and printer connection.  Choose the Setup option to 
change the printer and printer connection. 

• Setup 
Displays a Print Setup dialog box, so  you can select a printer and printer 
connection. 

• Print Range 
Specify the pages you want to print: 

• Copies 
Specify the number of copies you want to print for the above page range. 

• Collate Copies 
Prints copies in page number order, instead of separated multiple copies of each 
page. 

• Print Quality 
Select the quality of the printing.  Generally, lower quality printing takes less 
time to produce. 

Print Progress Dialog 
The Printing dialog box is shown during the time that the application is sending 
output to the printer.  The page number indicates the progress of the printing. 

To abort printing, choose Cancel. 

Print Preview command (File menu) 
Use this command to display the selected item as it would appear when printed.  
When you choose this command, the main window will be replaced with a print 
preview window in which one or two pages will be displayed in their printed format.  
The print preview toolbaroffers you options to view either one or two pages at a 
time; move back and forth through the document; zoom in and out of pages; and 
initiate a print job. 

Print Preview toolbar 
The print preview toolbar offers you the following options: 

• Print 
Bring up the print dialog box, to start a print job. 

• Next Page 
Preview the next printed page. 

• Prev Page 
Preview the previous printed page. 

• One Page / Two Page 
Preview one or two printed pages at a time. 

• Zoom In 
Take a closer look at the printed page. 
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• Zoom Out 
Take a larger look at the printed page. 

• Close 
Return from print preview to the editing window. 

Print Setup command (File menu) 
Use this command to select a printer and a printer connection.  This command 
presents a Print Setup dialog box, where you specify the printer and its connection. 

Print Setup dialog box 
The following options allow you to select the destination printer and its connection. 

• Printer 
Select the printer you want to use.  Choose the Default Printer; or choose the 
Specific Printer option and select one of the current installed printers shown in 
the box.  You install printers and configure ports using the Windows Control 
Panel.  

• Orientation 
Choose Portrait or Landscape. 

• Paper Size 
Select the size of paper that the document is to be printed on. 

• Paper Source 
Some printers offer multiple trays for different paper sources.  Specify the tray 
here. 

• Options 
Displays a dialog box where you can make additional choices about printing, 
specific to the type of printer you have selected. 

• Network... 
Choose this button to connect to a network location, assigning it a new drive 
letter. 

Most Recently Used Files 
The application maintains a list of the four most recently used files.  Clicking on 
their name with the mouse can reopen these files (or highlighting their name and 
pressing enter. 

If the file can not be found for any reason then it will not be possible to open it and 
the entry for that file name will be removed from the file list.  You can then either 
use the File – Open menu to look for the file or select another file from the remaining 
list of “Most Recently Used Files” 

Exit 
This command causes any open data files to be closed and the MLS file viewer 
application to exit. 
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View menu 
The View menu is very simple and allows you to decide if you want the Toolbar and 
Status Bar to be present and also has command which allows you to decide how you 
want to see the data. 

Toolbar 
This command can be used to display and hide the Toolbar, which includes buttons 
for some of the most common commands in The MLS file viewer, such as File Open.  
A check mark appears next to the menu item when the Toolbar is displayed. 

The toolbar is displayed across the top of the application window, below the menu 
bar.  The toolbar provides quick mouse access to many tools used in The MLS file 
viewer. 

 

 

Open command (File menu) 

 

Save command (File menu) 

 

Close command (File menu) 

 

Print Command (File Menu) 

 

About command (Help menu) 

 

SHIFT + F1 

 

Status Bar 
This command can be used to display and hide the Status Bar, which describes the 
action to be executed by the selected menu item or depressed toolbar button, and a 
progress meter. A check mark appears next to the menu item when the Status Bar is 
displayed at the bottom of the MLS file viewer window. 

The left area of the status bar describes actions of menu items as you use the arrow 
keys to navigate through menus.  This area similarly shows messages that describe 
the actions of toolbar buttons as you depress them, before releasing them.  If after 
viewing the description of the toolbar button command you wish not to execute the 
command, then release the mouse button while the pointer is off the toolbar button. 

Split 
This command causes the split between the two views to be activated and you can 
then use the LEFT and RIGHT arrow keys or the mouse to move the split to change 
the relative sizes of the two views. 
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Plots 
This command decides what you see in the Data View.  You can view the plots of 
the data item selected in the Main View or you can view the data as text.  There will 
be a check mark next to this item, if the data is being viewed in a plot.  This is 
relevant only to data that can be plotted. 

Window menu 
This menu contains commands that are useful in arranging the open windows in the 
application workspace. 

Cascade 
This command can be used to arrange multiple opened windows in an overlapped 
fashion. 

Tile 
This command can be use to arrange multiple opened windows in an non-overlapped 
fashion. 

Arrange Icons 
This command can be used to arrange the icons for minimized windows at the 
bottom of the main window.  If there is an open document window at the bottom of 
the main window, then some or all of the icons may not be visible because they will 
be underneath this document window. 

1,2, … command 
The MLS file viewer displays a list of currently open document windows at the 
bottom of the Window menu.  A check mark appears in front of the file name of the 
active window.  Choose a file from this list to make its window active. 

Help menu 
This menu contains commands useful in finding Help and to register the Application. 

Help Topics 
This command gives an index of the help topics that are available for the application.  
It is possible to search for a topic of interest.  Help is available by highlighting a 
menu item and then clicking the F1 key.  Help can also be sought by clicking the 
Shift-F1 keys.  This transforms the cursor into a help cursor and the user can click on 
the item of interest to see the help topic associated with it. 

CAMARC Help 
This command opens a Help file which gives you the format of the different DST 
lexicons. 
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Register… 
This command enables you to register this application if you have previously 
downloaded an evaluation copy and subsequently purchased a registration key for 
the program.  This command opens the Register dialog box.  Motion Lab Systems 
registration keys consist of a User Name, Organization Name and a sixteen digit 
serial number.  You must enter this information correctly before the application will 
export data from files with more than 100 frames. 

Register dialog box 
This dialog box can be used to Register the Application.  You can enter you name 
and organization and the 16 digit code given to you by Motion Lab Systems. 

 

This dialog box has the following fields: 

• User Name 
Enter the name of the User. 

• User Org 
Enter the Organization of the user. 

• Reg. Num. 
Enter the 16 digit code provided to you by Motion Lab Systems.  If The 
MLS file viewer is already registered, Licensed Copy will appear in 
this field. 

• OK 
Click on this button to validate the changes you have made and close 
the dialog box.  The modifications you made will be written to the 
registry and the code will be checked. 

• Cancel 
Click on this button to ignore all you changes and close the dialog box. 

MLS Home Page 
If you have an Internet connection and use the World Wide Web then you can launch 
your Internet Web browser directly from this item and visit the Motion Lab Systems 
Home Page.  You can check here for new updates to this application as well as 
download evaluation copies of other Motion Lab Systems software products.  You 
can also contact Technical Support directly from this Web Page. 

About The MLS file viewer 
This opens a dialog box provides information about the application. 

This dialog box shows you the following information: 

• The Name of the Application with the Application Icon. 

• The Version Number of the Application. 

• The Name and Organization of the user. 

• Whether you are using an Evaluation Copy or a Registered Copy of the 
Application. 
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General Information 
This section lists some general information about the Application. 

Title Bar 
The title bar is located along the top of a window.  It contains the name of the 
application and document. 

To move the window, drag the title bar.  Note: You can also move dialog boxes by 
dragging their title bars. 

A title bar may contain the following elements: 

• Application Control-menu button 

• Maximize button 

• Minimize button 

• Name of the application 

• Name of the document 

• Restore button 

Scroll Bars 
Displayed at the right and bottom edges of the document window, if the size of the 
window is smaller than what it should be to display the contents of the window.  The 
scroll boxes inside the scroll bars indicate your vertical and horizontal location in the 
document.  You can use the mouse to scroll to other parts of the document. 

Size command (System menu) 
 

This command can be used to display a four-headed arrow so you can size the active 
window with the arrow keys. 
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After the pointer changes to the four-headed arrow: 

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to 
move the pointer to the border you want to move.   

2. Press a DIRECTION key to move the border. 

3. Press ENTER when the window is the size you want. 

Note:  This command is unavailable if you maximize the window. 

Shortcut 

Mouse: Drag the size bars at the corners or edges of the window. 

Move command (Control menu) 
 

This command can be used to display a four-headed arrow so you can move the 
active window or dialog box with the arrow keys. 

 
Note:  This command is unavailable if you maximize the window. 

Shortcut 
Keys: CTRL+F7 

Minimize command (application Control menu) 
This command can be used to reduce the MLS file viewer window to an icon. 

Shortcut 
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Mouse: Click the minimize icon 

on the title bar. 

Keys: ALT+F9 

Maximize command (System menu) 
This command can be used to enlarge the active window to fill the available space. 

Shortcut 

Mouse: Click the maximize icon 

 on the title bar; or double-
click the title bar. 

Keys: CTRL+F10 enlarges a document window. 
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Next Window command (file Control menu) 
This command can be used to switch to the next open file window.  The MLS file 
viewer determines which window is next according to the order in which you opened 
the windows. 

Shortcut 
Keys: CTRL+F6 

Keys: CTRL+SHIFT+F6 to go to previous file window 
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Close command (Control menus) 
This command can be used to close the active window or dialog box. 

Double-clicking a Control-menu box is the same as choosing the Close command. 

Note:  If you have multiple windows open for a single file, the Close command on 
the file Control menu closes only one window at a time.  You can close all windows 
at once with the Close command on the File menu. 

Shortcuts 
Keys:  CTRL+F4 closes a file window 

 ALT+F4 closes the MLS file viewer window or dialog box 
 

Restore command (Control menu) 
This command can be used to return the active window to its size and position before 
you chose the Maximize or Minimize command. 

 

 
 

Viewing the Data 

File Information 
When you first open a file with the MLS file viewer the program will display some 
basic information about the file that you have just opened.  The header information is 
contained in the first line of the file and defines the format and lexicon information 
together with other details that are defined by the CAMARC file specifications. 
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The initial view when the MLS file viewer opens a file. 

The display panel on the right will also show the full file name and path together 
with the size of the file and the date that the file was last modified by the operating 
system – this may be different from the file creation date and the date that the 
information was collected. 

The left display panel will show the contents of the file in terms of data and 
variables.  The contents of this window will vary depending on the content of the file 
and the CAMARC lexicon used by the file. 

Variables 
DST files can contain data in the form of Text and Scalar variables – the names of 
these variables are listed in the left display pane.  You can view the contents of any 
variable by selecting it with the mouse.  When a text or scalar variable name is 
selected the MLS file viewer will display the value of the variable in the display pane 
on the right side. 

Text and Scalar values are displayed exactly as stored in the file. 
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Highlighting any text or scalar variable displays the value 

 

Vector Data 
DST files can contain data in the form of Vector variables – the names of these 
variables are listed in the left display pane together with other text and scalar data 
variables.  You can view the contents of any Vector variable by selecting it with the 
mouse.  When a Vector variable name is selected the MLS file viewer will display 
the data values in the display pane on the right side as a graph.  DST data will be 
displayed by sample number. 

 
Highlighting any vector variable displays a graph of the data. 

Vector variables name may contain more than one data value – for instance three 
dimensional coordinates will be stored as X-Y-Z values – a sequence of three 
numbers.  This can result in more than one graph being displayed.  Use the scroll 
bars on the display window to view all of the data. 
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Vector variables may display several graphs where the data is multi-dimensional. 
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